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1.1 Cloanto - The Kara Collection - Table of Contents

Welcome to The Kara Collection CD-ROM
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Introduction by Kara
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’Script’ DataType
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Technical Support
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Legal Notes

Copyrights
Disclaimer and Limitation of Liability
Trademarks

ColorFonts

Different Font Families
Character Sets
Specific Font Usage
Kerning (Letter Spacing)
Alternate Color Palettes
Using ColorFonts with Amiga Software: General Instructions
Using ColorFonts with Amiga Software: Personal Paint
Using ColorFonts with Amiga Software: Deluxe Paint
Using ColorFonts with Amiga Software: Broadcast Titler
Using ColorFonts with Amiga Software: PowerTitler and X-Titler
Using ColorFonts with Amiga Software: VideoTitler

AnimFonts

Specific Font Usage
Using AnimFonts with Amiga Software: Personal Paint
Using AnimFonts with Amiga Software: Deluxe Paint
Using AnimFonts with Amiga Software: Deluxe Video

Deluxe Paint Step by Step Instructions: Bullion AnimFont

Deluxe Paint Step by Step Instructions: Capsule AnimFont

Deluxe Paint Step by Step Instructions: ChromeChiselScript AnimFont

ChromeChiselScript AnimFont - Consecutive Letters
ChromeChiselScript AnimFont - Consecutive Words
ChromeChiselScript AnimFont - Consecutive Lines

Deluxe Paint Step by Step Instructions: ChromeScript AnimFont

Deluxe Paint Step by Step Instructions: KaraGothicChisel AnimFont

Plaquegrounds

Using Plaquegrounds with Amiga Software: General Instructions
Using Plaquegrounds with Amiga Software: Personal Paint
Using Plaquegrounds with Amiga Software: Deluxe Paint
Using Plaquegrounds with Amiga Software: Video Toaster

Starfields
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General Instructions
Using Starfields with a Space Object and a ColorFont or AnimFont
Using Starfields with two Space Objects
Using Starfields with two ColorFonts or AnimFonts
Adding Perspective
Example: Space Object Moving towards the Viewer

Cloanto ColorType

1. First Steps

1.1 Tutorial 1: How to Create a Color Font in Minutes
1.2 Tutorial 2: How to Create an Anti-Aliased Font

2. ColorType Advanced Features

2.1 The Macro Selection Requester
2.2 The Edit Macro Requester
2.3 The Rexx Interface

2.3.1 Input/Output Environment
2.3.2 Syntax conventions
2.3.3 Parameters and Options
2.3.4 Return Values
2.3.5 Warning and Error Codes

3. Rexx Command Reference

3.1 Center
3.2 Chop
3.3 Clear
3.4 Copy
3.5 DeleteFont PATH NAME SIZE/N STYLE
3.6 DynamicView TEXT/A
3.7 FlipHoriz, FlipVert
3.8 FontExists PATH NAME/A SIZE/N/A STYLE EXACT/S
3.9 Get SETTING/A
3.10 GetActivation CNUM/N
3.11 GetAttr ASCII/S
3.12 GetChar
3.13 GetEnv
3.14 GetKern CNUM/N
3.15 GetPen BKG/S FRG/S GRID/S REMAP/S
3.16 GetRefPoint REF1/S REF2/S REF3/S REF4/S
3.17 GetSpace CNUM/N
3.18 GetXSize CNUM/N
3.19 GetZoom
3.20 Help KEY COMMAND/S IOFORMAT/S
3.21 IsBlank
3.22 ListFonts PATH
3.23 LoadFont PATH NAME SIZE/N STYLE STRETCH/S NOSTRETCH/S
3.24 LoadImage FILE FORMAT PREVIEW/S STRETCH/S NOSTRETCH/S O...
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3.25 LoadPalette FILE
3.26 LockGUI
3.27 NewFont
3.28 Paste
3.29 Request TITLE/A DESCR/A RESIZE/S KEEPCOL/S NOVSPACE/S
3.30 RequestFile TITLE/A PATH FILE PROC CANC SAVEMODE/S FORM...
3.31 RequestFont TITLE/A PATH NAME SIZE/N STYLE PROC CANC SA...
3.32 RequestNotify TITLE PROMPT/A OK SCROLL/S WORDWRAP/S WRA...
3.33 RequestPath TITLE/A PATH PROC CANC
3.34 RequestResponse TITLE PROMPT/A PROC CANC
3.35 SaveDView FILE/A FORMAT OPTIONS/M/F
3.36 SaveFont PATH NAME
3.37 SaveFontImage FILE/A FORMAT OPTIONS/M/F
3.38 SaveImage FILE FORMAT OPTIONS/M/F
3.39 SavePalette FILE
3.40 ScreenToBack
3.41 ScreenToFront
3.42 Set STRETCH/S PARAMS/M/F
3.43 SetActivation STATUS/N/A
3.44 SetAttr ATTR/N/A SET/S CLEAR/S CHANGE/S
3.45 SetChar CHAR/N PREV/S NEXT/S PREVON/S NEXTON/S FIRSTON/...
3.46 SetEnv ENV/N/A
3.47 SetKern KERN/N/A
3.48 SetPen BKG/N FRG/N GRID/N REMAP/N
3.49 SetRefPoint REF1/N REF2/N REF3/N REF4/N
3.50 SetSpace SPACE/N/A
3.51 SetXSize XSIZE/N/A
3.52 SetZoom DOTHEIGHT/N BEST/S
3.53 ShiftDown, ShiftLeft, ShiftRight, ShiftUp
3.54 UnlockGUI
3.55 Version PROGRAM/S REXX/S

Cloanto Personal Fonts Maker

1. Introduction to the Amiga Environment

1.1 Documentation
1.2 System Configuration
1.3 Memory

1.3.1 Measurement Units
1.3.2 Random Access Memory (RAM)
1.3.3 The AddMem Command
1.3.4 Peripheral Units

1.4 File Names and Titles
1.5 Drawers
1.6 Backup Copies
1.7 ’Virus’ Programs
1.8 System Errors
1.9 The User Interface

1.9.1 Screens and Windows
1.9.2 The Mouse and the Pointer
1.9.3 Requesters
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1.9.4 Gadgets
1.9.5 Proportional Gadgets
1.9.6 String Gadgets
1.9.7 Icons
1.9.8 Menus

1.10 The Keyboard

1.10.1 The SetMap Command
1.10.2 Graphical Keys
1.10.3 Accents
1.10.4 The <Shift> Keys
1.10.5 The <Alt> Keys
1.10.6 The <Ctrl> Key
1.10.7 The <Commodore> Key
1.10.8 The <Amiga> Key
1.10.9 The <Caps Lock> Key
1.10.10 The Cursor Keys
1.10.11 The <Return> Key
1.10.12 The <BS> Key
1.10.13 The <Del> Key
1.10.14 The <Help> Key
1.10.15 The <Esc> Key
1.10.16 The Function Keys

1.11 Loading the Personal Fonts Maker
1.12 Environment Variables and Standard Drawers
1.13 Installing the Personal Fonts Maker

1.13.1 Automatic Installation: The InstallPFM Program

2. Personal Fonts Maker Basics

2.1 From Gutenberg’s Type to Computer Fonts
2.2 A Note on Style
2.3 Typeface Classification and Typographic Basics
2.4 Storage of Fonts
2.5 Downloaded Printer Fonts
2.6 Program and Font Parameters

2.6.1 The AUDC Parameter
2.6.2 The AUDE Parameter
2.6.3 The BRHA Parameter
2.6.4 The COLR Parameter
2.6.5 The COLG Parameter
2.6.6 The COLB Parameter
2.6.7 The COOR Parameter
2.6.8 The CSET Parameter
2.6.9 The EPIL Parameter
2.6.10 The FILR Parameter
2.6.11 The GRID Parameter
2.6.12 The ICON Parameter
2.6.13 The ITAF Parameter
2.6.14 The JOIN Parameter
2.6.15 The LANG Parameter
2.6.16 The MCRO Parameter
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2.6.17 The PROL Parameter
2.6.18 The RNGE Parameter
2.6.19 The SQON Parameter
2.6.20 The SQOF Parameter
2.6.21 The STCM Parameter
2.6.22 The WBEN Parameter
2.6.23 The XDPI Parameter
2.6.24 The XMAX Parameter
2.6.25 The YDPI Parameter
2.6.26 The YMAX Parameter

2.7 Programming the Output Format: The Cloanto FFDL

2.7.1 FFDL Constants
2.7.2 FFDL Variables

2.7.2.1 FFDL Variables: ATRB
2.7.2.2 FFDL Variables: CHQT
2.7.2.3 FFDL Variables: CIDT
2.7.2.4 FFDL Variables: CNUM
2.7.2.5 FFDL Variables: EQAM
2.7.2.6 FFDL Variables: FCLM
2.7.2.7 FFDL Variables: FRST
2.7.2.8 FFDL Variables: HDAT
2.7.2.9 FFDL Variables: HICD
2.7.2.10 FFDL Variables: KERN
2.7.2.11 FFDL Variables: LAST
2.7.2.12 FFDL Variables: LCLM
2.7.2.13 FFDL Variables: LENG()
2.7.2.14 FFDL Variables: REF1-4
2.7.2.15 FFDL Variables: REPT()
2.7.2.16 FFDL Variables: SPCE
2.7.2.17 FFDL Variables: VDAT
2.7.2.18 FFDL Variables: VIDT
2.7.2.19 FFDL Variables: XBYT
2.7.2.20 FFDL Variables: XDPI
2.7.2.21 FFDL Variables: XMAX
2.7.2.22 FFDL Variables: XSIZ
2.7.2.23 FFDL Variables: YBYT
2.7.2.24 FFDL Variables: YDPI
2.7.2.25 FFDL Variables: YMAX
2.7.2.26 FFDL Variables: YSIZ

2.7.3 FFDL Operators

2.7.3.1 FFDL Algebrical Operators
2.7.3.2 FFDL Relational Operators
2.7.3.3 FFDL Bit Manipulation Operators
2.7.3.4 FFDL Operator Priorities

2.7.4 FFDL Prefixes

2.8 Character Sets

3. PFM: The Screen
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3.1 The Character Editing Box
3.2 The ’Font’ Gadgets
3.3 The ’Character #’ Gadgets
3.4 The ’X Size’ Gadgets
3.5 The ’Space’ Gadgets
3.6 The ’Kerning’ Gadgets
3.7 The ’Default’ Gadget
3.8 The ’CLR’ Gadget
3.9 The ’UNDO’ Gadget
3.10 The ’ON/OFF’ Gadget
3.11 The ’Copy to Buffer’ Gadget
3.12 The ’Paste from Buffer’ Gadget
3.13 The ’Smaller’ Gadget
3.14 The ’Larger’ Gadget
3.15 The ’Dynamic View’ Gadget
3.16 The ’OR’ Gadget
3.17 The ’Pencil/Brush’ Gadget
3.18 The ’Define Brush’ Gadget
3.19 The Four ’Shift’ Gadgets
3.20 The Two ’Flip’ Gadgets
3.21 Reference Points
3.22 Quick Character Selection
3.23 The File Requester
3.24 The Font Requester

4. PFM: The Project Menu

4.1 New Font
4.2 Free Font Memory
4.3 Load PFM Font
4.4 Save PFM Font
4.5 Import Amiga Font
4.6 Export Amiga Font
4.7 Free Character Set
4.8 Load Character Set
4.9 Save Character Set
4.10 Define Character Set
4.11 Edit Character Set
4.12 Printer Test

4.12.1 Character
4.12.2 Font
4.12.3 Line Feed
4.12.4 Form Feed

4.13 Write Font Data

4.13.1 File
4.13.2 Printer

4.14 Font Statistics

4.14.1 Activation Table
4.14.2 ON Characters
4.14.3 Average Width
4.14.4 Widest Character
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4.14.5 Narrowest Character
4.14.6 Font Status

4.15 Memory Information
4.16 Delete

4.16.1 File
4.16.2 Amiga Font

4.17 About
4.18 Quit

5. PFM: The Brush Menu

5.1 Load Brush
5.2 Save Brush
5.3 Horizontal Flip
5.4 Vertical Flip
5.5 Rotate 90 Degrees
5.6 Italicize
5.7 Reverse
5.8 Resize

5.8.1 Stretch
5.8.2 Halve
5.8.3 Halve Horizontal
5.8.4 Halve Vertical
5.8.5 Double
5.8.6 Double Horizontal
5.8.7 Double Vertical

5.9 Handle

5.9.1 Upper Left
5.9.2 Upper Right
5.9.3 Centre
5.9.4 Lower Left
5.9.5 Lower Right

6. PFM: The Macro Menu

6.1 Load Macro
6.2 Save Macro
6.3 Start Record
6.4 End Record
6.5 Delete Macro
6.6 Examine Macro

6.6.1 Macro Commands: AFNT
6.6.2 Macro Commands: BHCE
6.6.3 Macro Commands: BHFL
6.6.4 Macro Commands: BHLL
6.6.5 Macro Commands: BHLR
6.6.6 Macro Commands: BHUL
6.6.7 Macro Commands: BHUR
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6.6.8 Macro Commands: BITA
6.6.9 Macro Commands: BRDH
6.6.10 Macro Commands: BRDO
6.6.11 Macro Commands: BRDV
6.6.12 Macro Commands: BRHA
6.6.13 Macro Commands: BRHH
6.6.14 Macro Commands: BRHV
6.6.15 Macro Commands: BROT
6.6.16 Macro Commands: BRST
6.6.17 Macro Commands: BRVS
6.6.18 Macro Commands: BSHM
6.6.19 Macro Commands: BVFL
6.6.20 Macro Commands: CLRC
6.6.21 Macro Commands: COFF
6.6.22 Macro Commands: CRON
6.6.23 Macro Commands: DOTM
6.6.24 Macro Commands: DVW0
6.6.25 Macro Commands: DVW1
6.6.26 Macro Commands: F1KD to F4KD
6.6.27 Macro Commands: F1KU to F4KU
6.6.28 Macro Commands: FLPH
6.6.29 Macro Commands: FLPV
6.6.30 Macro Commands: FONT
6.6.31 Macro Commands: KERN
6.6.32 Macro Commands: KRN-
6.6.33 Macro Commands: KRN+
6.6.34 Macro Commands: LBTD
6.6.35 Macro Commands: LBTU
6.6.36 Macro Commands: MEMR
6.6.37 Macro Commands: MKB0
6.6.38 Macro Commands: MKB1
6.6.39 Macro Commands: MOVE
6.6.40 Macro Commands: ORM0
6.6.41 Macro Commands: ORM1
6.6.42 Macro Commands: RBTD
6.6.43 Macro Commands: RBTU
6.6.44 Macro Commands: RCAL
6.6.45 Macro Commands: SELC
6.6.46 Macro Commands: SEL-
6.6.47 Macro Commands: SEL+
6.6.48 Macro Commands: SETR
6.6.49 Macro Commands: SHFD
6.6.50 Macro Commands: SHFL
6.6.51 Macro Commands: SHFR
6.6.52 Macro Commands: SHFU
6.6.53 Macro Commands: SPCE
6.6.54 Macro Commands: SPC-
6.6.55 Macro Commands: SPC+
6.6.56 Macro Commands: UNDO
6.6.57 Macro Commands: XSIZ
6.6.58 Macro Commands: XSZ-
6.6.59 Macro Commands: XSZ+
6.6.60 Macro Commands: ZOM-
6.6.61 Macro Commands: ZOM+

6.7 Execute Macro
6.8 Controlled Execution



00OO 10 / 14

6.9 Stop Execution
6.10 Step Execution

7. PFM: The Preferences Menu

7.1 Load Preferences
7.2 Save Preferences
7.3 Font Description

7.3.1 X Max
7.3.2 Y Max
7.3.3 X Dpi
7.3.4 Y Dpi
7.3.5 Prologue
7.3.6 ON Sequence
7.3.7 OFF Sequence
7.3.8 Epilogue
7.3.9 Range

7.4 Italic Factor
7.5 Coordinates

7.5.1 Start 0:0
7.5.2 Start 1:1

7.6 Grid

7.6.1 Lines
7.6.2 Dots

7.7 Workbench

7.7.1 Open
7.7.2 Closed

7.8 Icons

7.8.1 No
7.8.2 Yes (Default Font Icon)
7.8.3 Yes (Character Font Icon)

7.9 Joined Fonts
7.10 Stretch

7.10.1 Proportional X
7.10.2 Maximum X
7.10.3 Recall & Stretch

7.11 File Requester

7.11.1 Expand Path
7.11.2 List Icons
7.11.3 Double-Click
7.11.4 Confirm Overwriting

7.12 Language
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7.13 Audio
7.14 Colour Bias

8. PFM: The Attributes Menu

8.1 Italic
8.2 Bold
8.3 Light
8.4 Underlined
8.5 Outline
8.6 Shadow
8.7 Superscript
8.8 Subscript
8.9 Enlarged
8.10 Condensed
8.11 Reverse
8.12 Serif
8.13 Draft
8.14 Fixed Pitch
8.15 Right to Left
8.16 Landscape

9. The Printer Driver Modifier

9.1 How Printer Drivers Work
9.2 Problems with Standard Drivers
9.3 The PDM: General Description
9.4 The PDM: The Main Window

9.4.1 The ’Number’ Gadgets
9.4.2 The Editing Gadget
9.4.3 The ’Command’ Field
9.4.4 The ’Character’ Field
9.4.5 The ’Maximum’ Field
9.4.6 The ’Function’ Field

10. PDM: The Project Menu

10.1 Load Driver
10.2 Save Driver
10.3 Load Definitions

10.3.1 Commands and Characters
10.3.2 Commands
10.3.3 Characters

10.4 Save Definitions
10.5 Clear Definitions

10.5.1 Commands
10.5.2 Characters

10.6 Check Definitions
10.7 Section
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10.7.1 Commands
10.7.2 Characters

10.8 Flush Printer Device
10.9 About
10.10 Quit

11. PDM: The Preferences Menu

11.1 Code Table
11.2 Icons
11.3 Comments
11.4 Decoding Mode

11.4.1 Alphanumeric Symbols
11.4.2 Codes 0-7
11.4.3 Codes 8-32
11.4.4 Decimal Constants
11.4.5 Hexadecimal Constants
11.4.6 Octal Constants

11.5 Encoding Mode

11.5.1 Fixed Locations
11.5.2 Floating Locations
11.5.3 Strings on Word Boundary

11.6 Language
11.7 File Requester

11.7.1 Expand Path
11.7.2 List Icons
11.7.3 Double-Click

12. Other Utilities

12.1 TextChars
12.2 PrintRawFiles
12.3 RevLin
12.4 AskAssign
12.5 Predefined Macros

12.5.1 The ’Shadow’ Macro
12.5.2 The ’Outline’ Macro
12.5.3 The ’OutlineSqr’ Macro
12.5.4 The ’CopyOver127’ Macro
12.5.5 The ’SetSpcKrn’ Macro

12.6 Predefined Parameter Files

12.6.1 Parameter Files: ’StartupF1.prf’
12.6.2 Parameter Files: ’StartupF2.prf’
12.6.3 Parameter Files: ’SizeTable.prf’
12.6.4 Parameter Files: Printer Font Descriptions
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12.6.5 Parameter Files: Printer Driver Modifier Definitions

12.7 Predefined Fonts
12.8 Predefined Character Sets

13. Tutorial

13.1 Starting with an Amiga Font
13.2 A Simple Macro
13.3 Modifying a PFM Font
13.4 Downloading a Font to the Printer
13.5 Interacting with a Word Processor
13.6 Creating a Word Processor Font Size Table
13.7 Patching a Printer Driver

14. Problem Solving

14.1 Problems with Disks
14.2 Problems with Printers

A. Legal Notes

B. Hexadecimal, Decimal, Octal, Binary and ASCII Codes Table

C. The IBM PC Character Set (Code Page 437)

D. The Amiga Character Set (ISO 8859-1/ECMA-94)

E. 7-bit Character Sets

F. Selection of Amiga Printer Drivers

G. PFM Program Messages

H. PDM Program Messages

I. PFM Command Key Shortcuts

J. PDM Command Key Shortcuts

K. PFM Macros Command Short Names

L. PFM Macros Command Consistency Table
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M. Font Format Description Language Keywords

N. PFM Program and Font Parameters

O. PFM IFF Data Format

O.1 The IFF FORM: CPFM
O.2 IFF Chunks: IFHD
O.3 IFF Chunks: CHDT
O.4 IFF Chunks: CSNM
O.5 IFF Chunks: REFP

Cloanto Personal Paint

Personal Paint Demo
Personal Paint Upgrade

Cloanto Personal Suite
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